Your guide to using FactSet Academics

FactSet QuickStart
The following table lists commonly used reports in FactSet and their corresponding page numbers in this manual:

If you’re looking for...

Access this component by selecting the FactSet Insert menu:

See page number:

Navigating the FactSet Platform

1-4

Learning Tools

Additional Displays > Learning

5

Intraday News and Quotes

Quotes/Prices > Market Watch, Full Quote
News & Research > News, RSS Reader, Investment Research

6-7, 9-10

Historical Price, Volume, and Corporate Actions

Quotes/Prices > Price Reports

8

Research Management Tools

Research Management

11-12

Company Financials

Company > Overviews, Estimates, Financial Statements, Financial Analysis, or Filings
Microsoft Excel 2010 > FactSet tab > Filings drop-down menu > Filings Wizard

13-18, 20, 54

Comparable Companies

Company > Comparison

19

M&A and Deal Activity

Company > M&A

21-22

Takeover Defense Analysis (U.S. only)

Company > Corporate Governance

23

Company Debt and Bonds

Fixed Income > Fixed Income Explorer, DCS Overview

24-25

Company Investors and Ownership Statistics

Company > Ownership 2.0

26-27

Earnings Call Transcripts

Event Calendar

28

People Data

People > Snapshot

29

Portfolio Analysis

Portfolio > Portfolio View, Portfolio Analysis, Portfolio Dashboard, SPAR

30-34

Upload Proprietary Data and Manage Portfolios

Utilities > Quick Portfolio
Portfolio > Utilities > Portfolio List Manager

35-36

Markets and Economic Research

Markets > Index Breakdown, Constituents, Country Synopsis, or Economic Reports
Quotes/Prices > Full Quote

37-40

Screening

Screening/Report Writing > Universal Screening or Idea Screening 2.0

41-44

Charting

Charting > Chart, Interactive Charting

37, 45-46, 58

Web Browser

Web Browser

47

Wireless Access

Utilities > Wireless Configuration

48-49

Custom Models and Presentations

Microsoft Office: Excel, PowerPoint, and Word

50-60

support@factset.com
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Task List
This page lists common tasks and their corresponding page numbers in this manual.

Research Associates and Analysts

Investment Bankers

Performing Company Analysis:
Perform Company Analysis...............................................................................8, 13-18
Find Comparable Companies....................................................................................19
Find Standardized and As-Reported Filings...............................................................20
Monitor Company Events and Set Up Alerts..............................................................................28
View Company Debt.............................................................................................24-25
Research Company Boards........................................................................................29
Create Dynamic Charts..............................................................................................37, 45-46, 58
Screen for Companies..........................................................................................41-44
Research M&A......................................................................................................21-22
Analyze Global Equity Ownership Data................................................................26-27
Access FactSet Wireless........................................................................................48-49
Performing Market Analysis:
Track Real-Time News and Quotes..................................................................6-7, 9-10
Analyze Markets from Macro View.......................................................................37-40
Create Watchlists and Coverage Lists..................................................................19, 44
Managing Proprietary Data:
Create and Upload Portfolios....................................................................................35
Create Custom Composites.................................................................................36, 41
Creating Research, Ideas, Meetings, and Updating Clients
Access Research Management Tools....................................................................11-29
Find Institutional Investors and Contacts..................................................................29

The Basics:
Create Watchlists and Coverage Lists............................................................6, 19, 44
Track Real-Time News and Quotes.................................................................6-7, 9-10
Perform Private and Public Company Analysis...................................................13-15
Research Company Boards......................................................................................29
Track Private and Public Company Deal Activity......................................................21
View Private Equity Transactions.............................................................................16
Access FactSet Wireless......................................................................................48-49
Preparing for a Pitch:
Create a Public Information Book............................................................................14
Screen for Past Precedents and Comparable Deals.................................................21
Research Takeover Defense Data (U.S. only).....................................................14, 23
Create Dynamic Charts...........................................................................37, 45-46, 58
Create Dynamic Modules and Presentations...........................................55-57, 59-60
Preparing for the Road Show:
Analyze Global Equity Ownership Data...............................................................26-27

Portfolio Managers and Quantitative Analysts
Managing Data:
Create and Upload Portfolios...................................................................................35
Create Custom Composites................................................................................36, 41
Performing Analysis:
Track a Portfolio’s Absolute or Relative Performance in Real Time.........................30
Evaluate a Portfolio’s Fundamental Characteristics, Composition,
and Sources of Relative Performance.................................................................31-32
Perform Top-Level Portfolio Analysis Across Multiple Portfolios.............................33
Perform Returns-Based Portfolio Analysis...............................................................34
Simulate Trades and the Impact on Portfolio Performance and
Composition.............................................................................................................31
Creating and Analyzing Models:
Test and Confirm Investment Strategies.............................................................41-43

Marketing
Perform Top-Level Portfolio Analysis........................................................................33
Analyze a Portfolio’s Style, Performance, and Risk...................................................34
Evaluate a Portfolio’s Performance......................................................................30-32

Wealth Managers
Track Real-Time Markets and Off Hour Prices..........................................................6-7
Track and Filter Real-Time News.............................................................................9-10
Customize Views to Track Client Investments/Portfolio Views..................................30
Perform Company Analysis..................................................................................13-29
Access FactSet Wireless........................................................................................48-49
support@factset.com
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Accessing FactSet Content
This table shows just a few of the ways you can view FactSet’s proprietary content using the reports discussed in this manual. Additionally, you can access FactSet content in applications,
such as Universal Screening and Microsoft Excel templates. For a complete list of all FactSet’s content - including scope and coverage details - go to www.factset.com.
If you’re looking for...

Check out:

What is it?

Where?

Annual and Interim Financial

FactSet Fundamentals

Combines global coverage, deep company data, and unparalleled transparency for detailed historical financial statement content, per share data,

13-16, 18

Data

calculated ratios, pricing, and textual information to ensure a powerful data solution and access to industry-leading support staff dedicated to enhancing your workflow. Intraday updates deliver high-quality data faster than ever and source linking provides transparency back to the original filing.

Daily, Global Consensus and

FactSet Estimates

Detail Estimates

Combines a great breadth of data, such as daily, historical estimates on companies and sector-specific estimates. FactSet Estimates provides intraday

13-15,

revisions to ratings, target prices, and/or estimates, allowing you to monitor your portfolio performance intraday during earnings season, offers Click-

16-17

Thru for Actuals, Guidance, and Estimates, so you can drill down to analyst research reports, press releases, and much more.
Valuation, Ratio, and Per Share

FactSet Market Aggregates

Values on Aggregate Level

Combines information from FactSet’s Fundamentals, Estimates, and Prices databases to calculate valuation ratios, per share values, profitability

17-18, 40,

margins, and more on an aggregate level across a broad range of global indices or your own custom composites. The in-depth data lets you analyze

46

markets and portfolios with the same level of detail you use for security analysis and helps you assess market sentiment.
Global Economic Intelligence

FactSet Economics

Provides economic data, such as exchange rates, commodities, interest rates, benchmark data, and more to help you analyze complex relationships,

37-39

monitor developments, and transform your research into results. With the Standardized Economic database, you can make country comparisons by
normalizing currency, base years, report dates, and units, so you can integrate economic data into other FactSet reports and screens.
Fund, Institution, and Insider

FactSet Global Ownership

Collects global equity ownership data for institutions, mutual fund portfolios, and insiders/stakeholders, allowing you to access market-leading Free

Ownership Data

and Mutual Funds

Float numbers, fully-reported data to clarify information dates and minimize double counting, a fund contributor program that provides monthly

Conference Call Details and

FactSet Events and

Provides conference call transcripts for companies’ publicly held conference calls, plus a wealth of information regarding upcoming corporate events,

Transcripts

Transcripts

such as conference call dates and times, important company investor relations contact information, and much more.

Information about Private

FactSet Private Company

Provides descriptive and financial information, such as business description, management and board details, operations information, and more -

26-27

holdings not available to the market, and much more.

Companies

15, 44

targeting the companies most relevant to the banking industry.

Company and Portfolio Data

FactSet Private Equity and

Contains comprehensive information on global private equity firms and venture capital firms with details about a private equity or venture capital

Managed by PE and VC

Venture Capital

firm’s active as well as exited portfolio companies, including venture capital financing rounds, and more.

Public and Private Merger

FactSet Mergers

Provides detailed information on announced mergers, acquisitions, and divestitures involving both public and private companies worldwide and helps

Announcements and Deal Data
Public Debt Issues

28

16, 44
21-22

you analyze merger agreements to find highly negotiated aspects of a merger, as well as precedent language and transactions.
FactSet Fixed Income

Contains comprehensive current and historical pricing, ratings, and terms data for public debt issues for public and private companies. Data from

24-25

providers like Mergent, TRACE, and Telekurs is organized to ensure proper linking to an issuer’s bond terms, ratings, prospectuses, debt schedules,
capital structures, and more.
Corporate Governance or

FactSet Corporate

Covers takeover defense and shareholder rights, corporate activism, and proxy related issues. In addition, with FactSet Activism, you can monitor

Activism

Governance;

and analyze the latest activism data and activist profiles to help you gain insight into an investor’s history of activism by examining typical objectives,

FactSet Activism

tactics, and campaign outcomes.

FactSet Global Filings

Integrates global company filings from various sources, including EDGAR; SEDAR; debt, equity, and derivative prospectuses; annual reports; and data

Corporate Filings

14, 23

20, 54

from all public domains, such as stock exchanges, corporate actions, and M&A documents.
Profile Information

support@factset.com

FactSet People

Provides personal and professional information for individuals associated with public and private companies.
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Understanding Your Workspace
A workspace is made up of several tabs and subtabs that provide access to FactSet displays, reports, and applications. When you first launch FactSet, you will see either your last saved
default workspace or one of FactSet’s predefined workspaces. Workspaces are stored online and you can update and access them from multiple locations if you have FactSet installed on
a work, home, and/or laptop computer. For a guided tour of the FactSet platform, launch the eLearning tour on Online Assistant page 16493.

You can access additional tab options
by going to the Tab drop-down menu.

Enter an identifier in FactSearch to quickly
search for and navigate to securities, reports,
and applications within the new FactSet.

Use these toolbar buttons to save your workspace,
print, download, set application preferences, access
help for the new FactSet, and view your User Profile.
To open a blank tab and
add new components to
your workspace, click the
button next to the last
tab. You can add up to
three levels of tabs in each
workspace.
You can lock components
in a certain position or
press ALT+C to move the
component, view the title
bar, and access additional
options (shown here).

Selections include:
++Open Tab - To open a tab saved in
your Personal, Client, Super_Client, or
FactSet directory.
++Export Tab - To create a copy of the
current tab and share it with other
individuals at your firm.
++Rename Tab - To change the name of
the current tab.
++Close Tab - To close the current tab
and remove it from your workspace.
++Print Tab - To print the current tab.
++Revert Tab - To revert to the last
saved version of the current tab.
++Add Sub Tab - To create a new level
of tabs under your current tab.
++Display Outside FactSet - To display
the selected tab in a new window.
++Active Displays - To see a list of open
components in the current tab.
support@factset.com

FactSet allows you to send
and receive identifiers
from and to multiple
components throughout
your workspace using
Identifier Broadcast
and channel options.
See Online Assistant
page 15855 for more
information on Identifier
Broadcast options.
Online Assistant Page ID
15728
(1)
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Customizing Your Workspace
In addition to the workspace options shown on the previous page, you can customize your workspace to include additional displays, reports, and applications. You can then save your
new workspace and access additional workspace options using the new FactSet.

Inserting Components in Your Workspace

Managing Your Workspace

Click the Plus button next to the tab where you want to create a new tab and insert a
new component:

To manage workspaces, go to the FactSet Insert menu > Workspace and select:

++New Workspace - To create a new workspace.
++Open Workspace - To open an existing workspace file. You can also open a workspace
that you’ve launched recently by going to FactSet Insert menu > Recent Workspaces.
++Save Workspace - To save revisions to the current workspace.
++Save Workspace As - To save a collection of tabs and subtabs as a single workspace
file using a new name.
++Append Workspace - To append an additional workspace to your current workspace.
++Import from PC - To import a previously saved workspace or worksheet that is not
already included in your list of workspaces (any files with extensions .MQS and .MQW).
++Manage - To manage your workspace (e.g., move, copy, delete) using File Manager. See
Online Assistant page 14277 for more information on File Manager.

Launch a component by going to the FactSet Insert menu and selecting the desired
component. If you’re using a predefined workspace, you can also click a shortcut icon in
the toolbar to launch the corresponding component.

Follow the same steps to include additional components in your workspace. Once
you’re done customizing your workspace, learn how to save it for future use in the
next section.

Online Assistant Page ID

Where can I find this on FactSet?

15852, 15851

FactSet Insert menu > Workspace
support@factset.com
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Using Shortcuts and Function Keys
There are several predefined keyboard shortcuts available in the FactSet default workspaces. You can also customize the FactSet right-click menu, toolbar, and/or hot keys by assigning
shortcuts to your favorite displays, reports, and applications using Shortcut Manager.

Customizing Shortcuts and Hot Keys
To customize your shortcut toolbar and right-click options, click the Shortcut Manager button

in the toolbar.

2. Click the Add button to include the highlighted
component in the Selected Items list.

1. Select the component(s) you want to
assign a shortcut to from the Available
Items list. The list follows the same
order as the FactSet Insert menu so you
can easily find each item.

3. Click the Properties button to assign a
function key and format the appearance of the
shortcut in the toolbar.

Deselect the "Enable alternate keyboard
shortcut for Revert Tab (~ in the U.S.)"
check box to disable this option if it
conflicts with other functionality (e.g.,
FactSearch shortcuts). You can then
press CTRL+R to revert tabs.

Tip: You can also
categorize your
shortcuts so they
appear grouped in
your right-click menu.

Using FactSet Keyboard Shortcuts:
++To save a workspace and document (i.e., settings), press CTRL+S.
++To activate FactSearch or the Master Identifier box, press CTRL+T.
++To select the next component in a tab, press CTRL+TAB.
++To select the previous component in a tab, press CTRL+SHIFT+TAB.
++To navigate to the lowest tab layer, press ALT+[1-9].
++To toggle up/down through the tab layers, press CTRL+Up Arrow or Down Arrow.
++To move the cursor left in a tab layer, press CTRL+Left Arrow or Page Up.
++To move the cursor right in a tab layer, press CTRL+Right Arrow or Page Down.
++To close the active component, press CTRL+F4.

++To hide/show the identifier toolbar, press ALT+A.
++To hide/show scroll bars, press ALT+B.
++To hide/show a component’s title bar, press ALT+C.
++To activate the FactSet Insert menu, press ALT+F.
++To find text within a component, press CTRL+F.
++To tile components horizontally within a tab, press CTRL+SHIFT+ALT+H.
++To tile components vertically within a tab, press CTRL+SHIFT+ALT+V.
++To activate channel audit, press ALT+I.
++To display a component outside FactSet, press ALT+O.
++To revert back to the last saved version of a tab, press CTRL+R or the ~ key.

Online Assistant Page ID

Where can I find this on FactSet?

15797

Shortcut Manager button
support@factset.com
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Searching with FactSearch
FactSearch allows you to quickly search for and navigate to securities, indices, people, and FactSet components/reports. For a guided tour on using FactSearch, launch the eLearning demo
on Online Assistant page 16253.
Enter keywords into the FactSearch box. As you type, the
FactSearch drop-down menu will populate with results
related to the search keywords.

Expand the context-sensitive side menus to open a
component with the selected entity’s information. Select
"Broadcast ID" to send the entity to multiple components.

The drop-down menu is separated into the
following sections:

++Entities - Includes security types such as
equities, indices, people, mutual funds, and
private companies
++Components - Includes all the
components found in the FactSet Insert
menu
++Series & Reports - Includes economic
charts and series that are available in
Economic Analysis Charting
++Search Online Assistant - Opens an
Online Assistant search page with a list of
help pages that include your keyword

FactSearch Keyboard Shortcuts
You can quickly "jump" to a component, filing, or
Online Assistant page by entering shortcuts into the
FactSearch box. See Online Assistant page 16706 for
more information about FactSearch shortcuts.

++Component shortcut - identifier@shortcode (Examples: C@N - News for Citigroup; @PA - Blank Portfolio Analysis)
++Filings shortcut - identifier@filing (Example: KO@10K - Latest 10-K for Coca-Cola)
++Online Assistant shortcut - pageID@OA (Example: 16706@OA - "Using FactSearch Shortcuts" page in Online Assistant)
Tip: Enter “@” and the component name in the FactSearch
box to access the component shortcode. The shortcode is
also found on the component’s title bar.

support@factset.com

(4)
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Learning Tools in FactSet
The Learning tab provides a central location to access FactSet’s interactive eLearning demonstrations and tools, including the Financial Analysis Knowledge Base. The Knowledge Base
is a self-paced online training program and learning resource that concentrates on improving financial analysis and modeling in Excel. The Learning component also features several
eLearning demos that allow you to explore FactSet at your own pace.
Click the ? button and select "eLearning" to launch
context-sensitive demos for various displays, applications,
and reports throughout your workspace (requires FactSet
2010.1 and higher).

Starting with the basics of Excel, accounting, and finance,
and continuing on to advanced model-building, the
Financial Analysis Knowledge Base is an ideal continuing
education program for corporate finance analysis.
Navigate through
the tabs to view
lessons, a glossary,
a subject index, and
more. Self-paced
online courses
include interactive
screenshots and
video clips.

Access eLearning demos covering various FactSet
products and tools.

View tips and tricks
on using FactSet’s
Productivity Suite
to streamline your
daily workflow.

Subscribe to Notify’s "FactSet Learning Tools"
category to stay informed on the latest updates
for eLearning, Training and Online Assistant.

Online Assistant Page ID

Where can I find this on FactSet?

15722

FactSet Insert menu > Additional Displays > Learning (@LRN)
support@factset.com
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Monitoring Market Data
Monitor market data for securities, such as companies, indices, treasuries, currencies, futures, and commodities in the Market Watch display. You can manually enter identifiers, open an
existing ticker list, or view Universal Screening results. For more information on managing identifiers in Market Watch, see Online Assistant page 15884.
Click the drop-down arrow adjacent to the Lookup button
and select "Open Screen Results" to access securities that
pass a screen saved in Universal Screening.
Click the Lookup button to
select an identifier or type
an identifier directly into
the desired location.

Save your column layout
and access it from the
Layout drop-down menu.

Right-click an identifier and
select a report or market
data display from the
customized list to open
and dynamically apply the
identifier.

Right-click and select
"Options" to customize your
columns using data from
your FactSet subscription or
your proprietary data.

Double-click the N icon to
view news for the identifier
in the News display.

Double-click an identifier to apply the
identifier to all the company-specific
displays in the tab.

Select a row and enter G:group_name to create
group headings for your securities. You can also
right-click and select "Add New Group."

Market Watch Hot Keys:

Tip: To create and manage real-time alerts that will notify
you if certain criteria are met for a single or multiple
identifiers, use the Alert Manager utility (FactSearch
shortcut: @AM). For more information about Alert Manager,
see Online Assistant page 15873.

++To move around a Market Watch, press the Left and Right arrow keys.
++To copy an identifier(s), press CTRL+C.
++To cut an identifier(s), press CTRL+X.
++To paste an identifier(s), press CTRL+V.
++To select multiple identifiers, press CTRL or SHIFT.

Online Assistant Page ID

Where can I find this on FactSet?

15883

FactSet Insert menu > Quotes/Prices > Market Watch (@MW)
support@factset.com

Press the INSERT key to
insert a row. Press the
DELETE key to remove an
identifier, group, or row.

(6)
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Viewing a Full Quote
View a summary of a security’s trades, including bids and asks, along with fundamental data, such as EPS, P/E, and Price to Book Value in the customizable Full Quote display. You can
also view a ticker tape of the latest trade details and a candlestick chart of the intraday performance.
Access key reports, such as Performance Quote or Ownership,
via the drop-down menu on the Full Quote toolbar.

Click the linked values to launch
components related to the value.
For example, click the price value
to launch the Chart display or
click the FY1 EPS value to launch
the Estimate Tables report.

Tip: You can customize the Full Quote display using data
from your FactSet subscription or your firm’s proprietary
data and research. For more information on customizing a
Full Quote, contact FactSet Consulting Services.

By default, data is displayed in
local currency. Right-click and
select "Currency" to change the
display currency.

View a ticker tape and candlestick chart of the
intraday performance. If you do not see the
ticker tape, right-click in the display and select
"Show Ticker Tape."

Subscribe to Notify’s "Real-Time Data and Displays"
category to stay informed on the latest updates to
Full Quote and other real-time displays.
Online Assistant Page ID

Where can I find this on FactSet?

15894

FactSet Insert menu > Quotes/Prices > Full Quote (@FQ)
support@factset.com
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Accessing Pricing Data
The Price History report displays historical data for a single or multiple securities. View pricing and analytics for multiple security types (e.g., equities, bonds, indices, options, mutual
funds, warrants, futures, FX-rates, and more). This version of the Price History report requires FactSet 2011.5 or higher.
Enter an identifier or click the
Identifier Lookup button to search
for a security. See Online Assistant
page 14587 for more information
about Identifier Lookup.

Select a predefined date range
or click the Custom Date Range
button
to specify a date range.

Use the crosshairs by moving your
cursor over an area in the chart
to view the data charted on that
specific day.

View relevant header information
that is sensitive to the security type
entered into the report.
Select from a single or multiple
security report option using the
drop-down menu.

Click the gray arrow between the
sections to collapse or expand the
chart area. Right-click on the gray
arrow to change the report layout
from horizontal to vertical.

View indexed data and a chart by
selecting the Indexed option.

Right-click a column header to
select the columns you want to
view. Available columns vary for
each security type.

Double-click a column header to
sort the data in ascending order
or double-click again to sort in
descending order.

Tip: Zoom in on a section of
the chart by left-clicking on
your mouse and highlighting
a section of the chart.

Subscribe to Notify’s "Company
Analytics" category to stay informed
on the latest updates to security
analysis reports on FactSet.

Online Assistant Page ID

Where can I find this on FactSet?

15274

FactSet Insert menu > Quotes/Prices > Price Reports > Price History (@PH)
support@factset.com
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Viewing Real-Time News
In the News display, you can view real-time scrolling financial news headlines for the current day, a specific company, and a portfolio or watch list via a customized filter. For a guided tour
showing you how to text search and filter news, launch the eLearning series on Online Assistant page 16211.

Enter an identifier to view all
news for a single company.
Select the "Primary Identifier(s)"
option to include only stories
about the company in the
search.

Search for news by entering a keyword or
category code, or by clicking the Category Lookup
button to use predefined news searches by
subject, industry, language, country, and region.

Click New Search to create a news search
with your choice of data sources, categories or
subjects, universe of securities, and date range.
Click Top to quickly
see the top news from
Dow Jones News.
Right-click and select
"Options" to manage
display and search
options, as well as
display columns.

Double-click a headline to
view the full news document.
Duplicate headlines are
clustered together by default.

Click Include or
Exclude to add or
remove items from
your news search.
Each included/
excluded selection
will appear in the
Current Search/Filter
Criteria list.

Select a predefined filter to
narrow down stories.
Click More Headlines to view
more history for your current
news search.
You can break out tabs by
portfolio, security, or by the
results of a custom news search.
Right-click on the tab to move,
rename, or delete it.

Organize your search criteria using these tabs:
++Source - To select from the available news
sources (according to your subscriptions)
++Category - To select from a list of categories
++Universe - To specify an identifier or portfolio
++Text - To enter text criteria
++Date/Time - To specify a date range

Click the Save Alert
button to save your
search, create an
alert, and choose a
notification type.

Online Assistant Page ID

Where can I find this on FactSet?

15863

FactSet Insert menu > News & Research > News (@N)
support@factset.com
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Accessing RSS Reader
Use RSS Reader to gather and view headlines from multiple websites in a single application. RSS Reader includes default feeds from the Financial Times, Forbes, and Dow Jones. In
addition, you can add RSS feeds from your favorite sites. To learn more about using RSS Reader in FactSet, launch the eLearning demo on Online Assistant page 15876.

Enter a keyword in the Search textbox
and click the Search button.

Click the Settings button
to specify how headlines
should appear and how
much history to display.

Select a feed and right-click on
the name to select one of the
following options:
++Delete - To delete the feed
++Show URL - To view and copy
the feed URL
++Enable Wireless Access - To
view content from the feed in
FactSet’s mobile applications
++Mark all stories in this feed/
folder as read - To mark all
stories as read; this resets the
count to 0
++Export - To export the feed to
an OPML file for import into
another RSS reader

Double-click a headline to
view the story.

Click the Import button to import
feeds from other RSS readers.

Click the Add Group button to
organize your feeds into groups.

Click the Add Feed button to add
a feed from your favorite website.

Online Assistant Page ID

Where can I find this on FactSet?

15876

FactSet Insert menu > News & Research > RSS Reader (@RSS)
support@factset.com
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Creating Research, Ideas, and Meetings
Use the Create Research/Idea/Meeting dialog box to create internal research notes, trade ideas, and meetings in a single location, streamlining the process of creating and communicating
ideas. To access the full suite of Research Management tools, go to FactSet Insert menu > Research Management.
Choose the Trade Idea tab to create an
idea and initiate performance tracking
of the idea. The Trade Ideas tool helps
to evaluate who is contributing the best
performing idea recommendations.

Choose the Internal Note tab (as shown)
to create notes on a company, industry,
sector, or market and share them with
other FactSet users at your firm.

Classify your Internal Research Note
with a subject, sentiment, and/or
recommendation.

Choose the Meetings tab to create new
meetings. The Meetings tool lets you keep
a record of who attended meetings and the
broker who set up the company meetings,
as well as perform a subjective internal
assessment of meetings.

Use formatting tools to style your
notes, or copy and paste to add graphs
and images.

Add custom fields to your Internal
Research Note using manually-entered
data, FactSet formulas, or predefined lists.
For more information on adding custom
fields, see Online Assistant page 14358.

Click the Attach button to attach
supporting documents and models.

Add related symbols to your note by
entering the identifier or searching for it
using Identifier Lookup.

Subscribe to Notify’s "Research
Management” category to stay
informed on the latest updates to
Creating Research, Ideas, and Meetings.

Online Assistant Page ID

Where can I find this on FactSet?

14758

FactSet Insert menu > Research Management > Create Research/Idea/Meeting (@CRI)
support@factset.com
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Using Research Management Data
In addition to components like Internal Research and Performance Monitor, you can integrate the information you add to your Research Notes, Trade Ideas, and Meetings throughout
FactSet to suit your workflow. To access the full suite of Research Management tools, go to FactSet Insert menu > Research Management.
Compare proprietary data with market data in
Market Watch. Perform column math and see
the latest information directly as it is inputted.
Add annotations for your research
management data in Charts. Hover over the
annotation for a basic overview, then click it for
more detail.
Add alerts relevant to your research through
the News component.
Use Performance Monitor to identify your topperforming brokers and internal analysts. View
top-level aggregate performance calculations,
including number of ideas, success ratios, and
average returns.

Use the Internal Research display
to see everything that has been
posted on a certain security,
including related symbols, subsecurities, sectors, and more.

Subscribe to Notify’s "Research Management" category for
updates on all of FactSet’s Research Management products.

Click on a name in the Group view,
and the Idea List view will display
only the idea data for that group.
Online Assistant Page ID

Where can I find this on FactSet?

16251

FactSet Insert menu > Research Management
support@factset.com
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Accessing the Buy-Side Public Company Snapshot
The Public Company Snapshot - IM report provides a summary of a company's business and financial data for buy-side professionals. This report includes an in-depth view of a
company's price, performance, growth, valuation, estimates, and more. For a guided tour of the Company tab, which features the Company Snapshot report, launch the eLearning demo
on Online Assistant page 15948.
View the company's next
report date and hover
over the date to access
detailed estimates data
from FactSet Estimates.

Enter a company name or
identifier. You can also
click the Lookup button to
search for identifiers.
Hover over the company
name to launch the
Company Profile and
Country Synopsis reports.
See Online Assistant page
16638 for more information
on the Company Profile
report.

View key statistics, such
as enterprise value and
analyst coverage, for
your selected company.

Right-click the Price/Volume
chart to change formatting,
add custom annotations,
and more.
Hover over linked values
to access a drop-down
menu that launches related
reports (e.g., launch a
Press Release and Surprise
History report from an
actual Sales value).

Scroll right to view Quick Links and
Economic Links for more information on
the company and to launch economic
reports related to the company's country.

Subscribe to Notify's "Company Analytics" category
to stay informed on the latest updates to the Public
Company Snapshot - IM report.

Online Assistant Page ID

Where can I find this on FactSet?

15131

FactSet Insert menu > Company > Overviews > Public Company Snapshot - IM (@SNP)
support@factset.com
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Accessing the Sell-Side Public Company Snapshot
The Public Company Snapshot - IB report provides a summary of a company’s business and financial data for sell-side professionals. This report includes valuation items, ratios, and
relevant data, such as takeover defense, business segment sales, M&A deals, key comps, insiders/stakeholders, and more. The Snapshot report serves as a launching point to other data
sets and reports.
Enter a company name
or identifier, or click the
Lookup button to search for
identifiers.

Click the "Build TravelBook"
link to create a presentationready company overview.

Click the "More" links to view
detailed informaton for a
specific section.

Click the "Build PIB" link
to customize a Public
Information Book.

Click the Download button
to download any section of
the report into Microsoft Excel
or Word.

Click the link to toggle
between Market Value and
Equity Value. See Online
Assistant pages 14561 and
14405 for breakdowns of
the Market Value and Equity
Value calculations.

View the data source used in
the lower-right corner of each
report section.

Scroll down to view
additional information,
including the company’s
relative defense protection,
by looking at the Bullet
Proof Rating. (The Bullet
Proof Rating is a scale from
1-10, where 10 is the highest
level of takeover defense.)

Subscribe to Notify’s "Company
Analytics" category to stay
informed on the latest updates
to the Public Company Snapshot
- IB report.

Online Assistant Page ID

Where can I find this on FactSet?

14176

FactSet Insert menu > Company > Overviews > Public Company Snapshot - IB
support@factset.com
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Accessing Private Company Data
Use the Private Company Snapshot report to research private companies with summary information from the major data sources available on FactSet. The Private Company Snapshot
report includes a financial summary, valuation ratios, entity structure, management and board details, key competitors, and more.
Tip: To continue your private
company analysis on FactSet,
launch the Financial reports
or Idea Screening 2.0.

View a detailed description of
the company and its purpose,
including the company’s products,
headquarter information, and
founding year. You can also click
on a link to be directed to the
company’s website.

Scroll down to view the Financial
Summary section to help you
better understand the financial
situation of a company.

Click the Relationships icon to
launch the Relationships report,
which displays the business,
charitable, educational, and other
non-corporate relationships of the
targeted investment professional.
See Online Assistant page 13501
for more details about the
Relationships report.

Click the "IS" (Income
Statement), "BS" (Balance
Sheet), "CF" (Cash Flow), "Key
Items", or "Ratios" links to
launch the respective reports.
From there, you can create
charts in each report for
different line items.

Subscribe to Notify’s "Company Analytics" category to stay informed
on the latest updates to private company data on FactSet.

Online Assistant Page ID

Where can I find this on FactSet?

14087

FactSet Insert menu > Company > Overviews > Private Company Snapshot (@PRV)
support@factset.com
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Accessing the Private Equity/Venture Capital Report
Use the Private Equity/Venture Capital report to research descriptive investment information for private equity and venture capital firms, such as funds under management, active portfolio
companies, and more.
Enter a firm name or identifier,
or click the Lookup button to
search for firms.

Click a Disclosure link to
view deal details.

View the different report
sections to see the firm’s
active portfolio investments,
active private equity or venture
capital investments, latest
M&A deals, and more.

Expand a section to view
company summaries, known
investors, and other detailed
information.
Scroll up and down the
report to view funds
under management,
industry focus, key
people, and more.

View all private equity/venture
capital investments.

Subscribe to Notify’s "Company Analytics"
category to stay informed on the latest
updates to Private Equity/Venture Capital.
Online Assistant Page ID

Where can I find this on FactSet?

16043

FactSet Insert menu > Company > Overviews > Private Equity/Venture Capital (@PVC)
support@factset.com
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Accessing All Estimates & Broker Outlook
The All Estimates report displays all consensus estimates, actuals, and guidance figures available on a variety of report periods for a given company. The Broker Outlook report provides
an overview of broker research and information through an interactive chart with broker estimates; consensus and pricing history; and data containing broker information, estimates,
guidance, and more. For a guided tour of the Company tab, which includes the Estimates reports, launch the eLearning demo on Online Assistant page 15948.
View the company’s next report date and
hover over the date to access detailed
estimates data from FactSet Estimates.

Select the type of report
(e.g., both fiscal years and
quarters) to display from
the Report Type dropdown menu.

Click the Currency button to
access currency and exchange
rate selection options.

Hover over report values
and click the dropdown arrow to select
"Broker Detail" and view
the underlying broker
estimates. Depending on
the value selected, you can
also see Surprise History,
Estimate History, and a
Consensus Trend Chart.
View business segment
data such as domestic
and international data for
sectors including Hotel,
Retail, and Oil/Gas.

Click the Brokers
button to include/
exclude brokers in
your report. Also, click
the Settings button to
access further options,
such as setting the
estimate window.

Hover over an excluded
broker data item to view
the reason for exclusion.
Not Comparable figures use
a methodology that differs
from the default majority.

Click the Research
Report icon to source
link the data back
to the value in the
document from which
it was extracted.

Subscribe to Notify’s "Company
Analytics" category to stay informed on
the latest updates to FactSet Estimates.

Online Assistant Page ID

Where can I find this on FactSet?

14898, 15175

FactSet Insert menu > Company > Estimates > All Estimates or Broker Outlook (@EST or @BO)
support@factset.com

Tip: You can also
access FactSet Market
Aggregates data in
your report. See
Online Assistant page
15316 for more details.

(17)
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Viewing Company Financials
You can research and audit company data for a given identifier with the Financials reports on FactSet. This page highlights the Income Statement report, but you can access additional
financial reports, including Balance Sheet, Cash Flow Statement, Key Items, Operating Metrics, Ratios, and more in the Financial Statements and Financial Analysis sections of the
Company component. For a guided tour of the Company tab, which includes the Financials reports, launch the eLearning demo on Online Assistant page 15948.

Hover over the security
name to quickly launch
the Company Profile
and Country Synopsis
reports, view security
type, exchange, sector and
industry information,
and more.

Click on the Price link to
launch a Price Volume chart in
Interactive Charting.

View the company’s next report date and hover over the date to
access detailed estimate data from FactSet Estimates. For more
information, see Online Assistant page 16612.

Click the data source link
to change the database
order for your reports.
Click the More Options
button for advanced
report options, in order to
change units, adjust data
presentation, specify LTM
methodology, and select
data auditing.

View growth and ratio data
alongside the actual data
values for a company or
compare company data to
a related benchmark with
the FactSet Fundamentals
and FactSet Market
Aggregates databases.
See Online Assistant page
16770 for more details.

Using the FactSet
Fundamentals database,
hover over data items to
view a breakdown of the
calculations and source
link the value back to the
filing. See Online Assistant
page 15775 for more
information.

View intraday preliminary
data for companies
with the FactSet
Fundamentals database
in the "Preliminary"
column. See Online
Assistant page 16545 for
more information.

Online Assistant Page ID

Where can I find this on FactSet?

14859

FactSet Insert menu > Company > Financial Statements > Income Statement (@IS)
support@factset.com
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Comparing Company Financials
The Comparison reports provide detailed information about comparable companies for your target company, including key financials, margins, industry specific metrics, and price
performance. Use predefined FactSet reports with specific metrics or create your own custom report. You can also save your custom lists of comparables for future use.

Click the Options button to change the
report layout, currency, date, and the
statistics displayed in the report. For more
information on the Options available, see
Online Assistant page 16839.
Click a link to view a breakdown of the
value.

View industry-specific data in your
report by adding items from the
Industry Metrics category.
Select the Custom category to add a
custom column to your report. You
can then create your custom formula
after entering a name and heading
for the column.

Click the Open button to access other
predefined comparison reports. Then, choose
the FactSet directory in the left pane, select a
report, and click the Open button.
Click the Change Comps button to change the comparables
for your target company. For more information on selecting
comparables, see Online Assistant page 12033.

To reorder items in your report, click
the Up/Down buttons and the Move
Top/Move Bottom buttons next to
the list of Selected Items.

Subscribe to Notify’s "Company Analytics" category to stay
informed on the latest updates to the Comparison report.
Online Assistant Page ID

Where can I find this on FactSet?

16838

FactSet Insert menu > Company > Comparison
support@factset.com

(19)

Copyright © 2012 FactSet Research Systems Inc. All rights reserved.

Viewing Company Filings
Use the Filings report to analyze both U.S. and non-U.S. companies’ documents from EDGAR, SEDAR, PDF annual reports, and the FactSet Global Filings site (GlobalFilings.com).
Click the "Prospectus Screening" link to launch FactSet Global
Filings, which offers full text, clause, and field searching on debt,
equity, and warrant prospectus.

Quickly view recent filings using the
links at the top of the report.

Click the Filings Wizard
button to download asreported financials into
Microsoft Excel.

Click the Print button to print
a complete filing or sections
of a filing, as well as multiple
filings in a batch print.

Perform advanced searches,
filtering documents by date,
filing type, and text string.

To view the Blackline report,
click the Launch Blackline
Report icon next to the
corresponding filing.

Subscribe to Notify’s "Company Analytics"
category to stay informed on the latest
updates to company filings on FactSet.

The Blackline report allows you to view
a comparison of a company’s 10-K or
10-Q filing to the previous period’s
filing. For more information, see Online
Assistant page 14370.
Online Assistant Page ID

Where can I find this on FactSet?

14010

FactSet Insert menu > Company > Filings > Filings (@F)
support@factset.com
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Accessing M&A Summary Data
View global merger and acquisition data, deal details, and private placements in the M&A Summary report. You can also track detailed information on a company’s latest deal activity
including announce date, deal value, and advisors.

Click the "Build M&A
TravelBook" link to create a
presentation-ready, printable
report on a company’s M&A
deal activity.

Review deal activity by price
and volume for the last 12
months. Right-click on the
chart to format or copy the
chart. To view details, hover
your cursor over the red and
green flags.

Click the Detail Link icon
to view the deal synopsis,
transaction notes, and financials
for the target and buyer.

The M&A Summary provides
an overview of LTM deal
activity sourced from FactSet
Mergerstat.

Click the Source Link icon to
view source information for the
deal, such as press releases or
company filings.
Scroll down to view additional
information, including the
company’s latest M&A deals as
a seller, new issues, and its most
recent private placement deals.

Subscribe to Notify’s "FactSet Deal Data" category to
stay informed on the latest updates to FactSet Mergers.

Online Assistant Page ID

Where can I find this on FactSet?

14351

FactSet Insert menu > Company > M&A > Summary (@MA)
support@factset.com
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Accessing M&A Data Using FactSet Mergers
FactSet Mergers includes both Mergerstat and MergerMetrics. You can view pre-formatted reports, or create your own columnar reports to view advisors, premiums, and transactions.
For a guided tour of the Mergerstat and MergerMetrics components, launch the eLearning demos on Online Assistant page 16269.

Choose the MergerStat tab to view
detailed information on publiclyannounced global mergers,
acquisitions, and divestitures involving
public and private companies.

Choose the MergerMetrics tab to
find information about acquisitions
of public or private U.S. companies
where a definitive merger agreement
was filed with the SEC.

Once you execute a search, view your
results in the Results tab.
Tip: You can also view the All
Transaction as Buyer and All
Transaction as Seller reports
within FactSet Insert menu >
Company > M&A. See Online
Assistant page 14349 for
more information.

In both the MergerMetrics and
Mergerstat applications, you can
search and report on hundreds of
transaction items.

Subscribe to Notify’s "FactSet Deal Data" category to
stay informed on the latest updates to FactSet Mergers.
Online Assistant Page ID

Where can I find this on FactSet?

15444

FactSet Insert menu > Company > M&A > Mergerstat / MergerMetrics (@MGR or @MGM)
support@factset.com
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Viewing FactSet Corporate Governance Data
FactSet Corporate Governance (SharkRepellent) provides takeover defense data, corporate activism, and proxy-related research. You can use Corporate Governance to compile information
from a U.S. public company’s articles of incorporation, bylaws, shareholder rights plan, and state takeover law to build a comprehensive overview of a company’s key takeover defenses.
Create alerts to stay informed of
breaking activist news, poison pill
activity, campaign announcements,
13D filings, and more.

Search for defense profiles and
analytics on a wide range of
corporate governance criteria.

Click to view an in-depth report based
on the search criteria, plus links to
the company’s filings.

Tip: Analyze activist developments
and profiles using the Activism
(SharkWatch) tab. Also, choose the
Proxy tab to spot trends in proxy
voting, including management and
shareholder proposals and elections.
View the “Bullet Proof Rating,” a proprietary
weighted-average index comprised of significant
components that impact takeover defenses.

Click links to view corresponding
profile reports.
View ownership details and financials
from the FactSet Ownership and
Fundamentals databases.

Subscribe to Notify’s "FactSet Deal
Data" category to stay informed on
the latest updates to FactSet Mergers.

Click to review the complete charter
and bylaws currently in effect for your
chosen company.
Online Assistant Page ID

Where can I find this on FactSet?
FactSet Insert menu > Company > Corporate Governance > Corporate Governance - SharkRepellent.net (@CGV)
support@factset.com
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Analyzing Fixed Income Securities
The Bond Valuation report is an interactive calculator that provides valuations, yields, price sensitivity calculations, and cash flow information for up to 10 debt securities. For a guided
tour of the Bond Valuation report and other fixed income reports, launch the eLearning series on Online Assistant page 15519.
Click the Options button to customize
multiple report options at once. For
more information on report options, see
Online Assistant page 15391.

Enter a security identifier or click
the Lookup button to search
under specific categories, such as
Bonds, Municipal Debt, Preferreds,
and Mortgages.

Use the date quick link to easily change
the date for your report.

Access other Fixed Income
Explorer reports in the left pane
of the application. For more
information on managing your
Fixed Income Explorer reports, see
Online Assistant page 16048.

Change the prepayment assumption for
mortgage-backed securities using the
Prepayment Model Wizard. For more
information on selecting prepayment
assumptions, see Online Assistant page
15317.

Click the "Calculation Inputs"
header to collapse the inputs
section to more clearly see the
output data.

Use the context-sensitive right-click
menu to customize your report. For
example, if you right-click in the outputs
section, you can add or remove a data
item; if you right-click in the report
footer, you can add or remove report
footers.

Tip: Modify any of the
calculation inputs and
recalculate the data by clicking
the Calculate button in the
report toolbar. If a calculation
input is grayed out, it’s not
applicable to the security type.

Tip: View derived values and terms
and conditions for a single security
in the Security Overview report
(FactSet Insert menu > Fixed Income
> Security Overview). For more
information, see Online Assistant
page 15588.

Subscribe to Notify’s "Fixed Income
Solutions" category to stay informed
on the latest updates to fixed income
reports and data.

Online Assistant Page ID

Where can I find this on FactSet?

15574

FactSet Insert menu > Fixed Income > Fixed Income Explorer > Bond Valuation (@FIE)
support@factset.com
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Viewing Debt Capital Structure
The Debt Capital Structure (DCS) Overview report provides a broad and comprehensive overview of debt associated with an issuer. It includes current credit ratings, credit spreads, price
and CDS history chart, historical credit analysis, debt capital structure summary, liquidity summary, and data for long-term debt by maturity and debt seniority. For a guided tour of the
Debt Capital Structure and other fixed income reports, launch the eLearning series on Online Assistant page 15519.
View the current credit rating and
click a rating link (e.g., Aaa) to
access a detailed long-term rating
history for the issuer and related
issuer ratings.

Select the report period from the
drop-down menu.
Click the “DCS Detail” link to view a
break down of all the instruments
and line items that reconcile to the
balance sheet debt values.

Hover over the Price & CDS History
chart to view the one-year and
five-year CDS points, as well as the
equity price of the issuer.

View the debt capital structure
summary broken down by class,
as well as current short-term debt
information.

View historical credit analysis for
a quick overview of relevant credit
ratios. Click the date links in the
section to be directed to the issuer’s
source filings.

View the available revolving credit
facilities and cash numbers in the
Liquidity Summary.

Click the value links to audit the data
back to the source document using
FactSet Fundamentals.

Track a company’s debt maturity
schedule and view a year-by-year
summary of when bonds mature.

Track long-term seniority and view
the dollar value of debt at each level
of seniority.

Subscribe to Notify’s "Fixed
Income Solutions" category to stay
informed on the latest updates to
fixed income reports and data.

Online Assistant Page ID

Where can I find this on FactSet?

16102

FactSet Insert menu > Fixed Income > DCS Overview (@DCS)
support@factset.com
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Viewing Company Time-Series Data in Ownership 2.0
Ownership 2.0 allows you to see which institutions, mutual funds, and individuals have invested in a company, or to monitor which securities a given institution or fund owns. You can
apply groupings such as sectors or regions, include historical and peer data, and create custom charts for a single point in time or for a time series. For a guided tour of Ownership 2.0,
launch the eLearning series on Online Assistant page 15326.

Change report type
to see just institution,
mutual funds, insiders,
institution/insiders, or
all of the holders for the
selected equity.

Click the Options button to customize
your report settings.

Download any report into a
Microsoft Excel spreadsheet.

Click the Swap button to view
cross holding ownership.

Choose the Groupings tab to
layer groupings and create
custom groups such as Asset
Class. Additional tabs allow
you to exclude or hide funds,
add or remove columns,
change currency, and
customize your charts.

The Investor Type History
report (as shown) tracks
the types of holders that
are making moves in
and out of a stock over a
specified time period.

Access additional
Ownership 2.0 reports,
which each provide a
unique way to analyze
data from the FactSet
Ownership database.
Double-click a grouping
to expand or collapse it.
Subscribe to Notify’s "Ownership"
category to stay informed on the
latest updates to Ownership 2.0.

Choose the Universe tab in the Options
dialog box to add individual identifiers or a
saved watch list to your report. The Dates
tab allows you to change your report periods.
Online Assistant Page ID

Where can I find this on FactSet?

15361

FactSet Insert menu > Company > Ownership 2.0 (@OS2)
support@factset.com
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Viewing a Holder Report in Ownership 2.0
The FactSet Ownership database collects global equity ownership data for over 26,000 global financial sponsors, 32,000 mutual fund portfolios, and 400,000 insiders/stakeholders.
Ownership 2.0 provides a powerful, fully customizable application to analyze this data through single time or time-series pricing reports, company details, charts, and more. For a guided
tour of Ownership 2.0, launch the eLearning series on Online Assistant page 15326.
Use the Ownership 2.0 toolbar to change
the formatting of your report, add a title
or footer, sort and expand a grouping,
include or remove an outlier, and more.

Manage your reports,
customize them, and access
them quickly by displaying
them in the left pane.

Organize holdings of a company, fund, or
shareholder using custom groupings, then
double-click on a column header to sort by
that column.

Select a Holder report to
perform summary and
comprehensive share
ownership analysis on
the holdings of specific
institutions and mutual
funds.

Click any linked item to access more
detailed information. Easily refocus your
report on a specific holder or mutual fund
by selecting it, right-clicking, and choosing
a report from the drop-down menu.

Select the “Sector Analysis”
report (as shown) to track
sector and geographic
trends over time, analyze
buys and sells based on
price movements, and
review multiple holders at
one time. You can also use
watch lists of securities to
filter results.
Subscribe to Notify’s "Ownership" category to stay
informed on the latest updates to Ownership 2.0.

Chart any items in your report over a time series or
single point in time. Choose a report from the left pane,
create your own customized chart to download or print,
or click the Chart button in the application toolbar.
Online Assistant Page ID

Where can I find this on FactSet?

15375

FactSet Insert menu > Company > Ownership 2.0 (@OS2)
support@factset.com
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Viewing Corporate Events & Transcripts
The Event Calendar (FactSet 2011.3 and higher) displays historical and upcoming events such as earnings releases, stock splits, dividends, analyst meetings, guidance, and sales calls.
You can print and download events and receive email alerts for upcoming events. For a guided tour of Event Calendar, launch the eLearning series on Online Assistant page 16202.
Click the Tools button to
select your preferred file
format, calendar notification
options, time zone, and more.

Enter a ticker or name in the
Identifier box to find events for a
specific company. To search for
companies, portfolios, or indices,
click the Lookup button.

View up to four columns
of events in Day(s) view to
minimize your need to scroll
down or across.

Choose the Economic tab to view
event details within minutes
of their release. View real-time
data on the indicator and period
covered in the release, forecasted
or actual figures, the market
median forecast, and more.

Click an identifier to open the
Single Company view, which
provides transcripts for the
company’s past events and
details about future events.
Launch an audio file or
download a transcript for
an event by clicking the
appropriate icon.

Use the interactive calendar to
narrow your search. Click a date
to select the specific day or the
arrow buttons to select a full
week or month. You can also
input a custom date range.

Subscribe to Notify’s "FactSet Event
Calendar" category to stay informed on
the latest updates to Event Calendar.

Limit results by event type,
region, and industry. You can also
include market holidays and your
firm’s meetings.

Click an event link to view
detailed event and company
information for the selected
ticker, including links to additional
documents where available.
Online Assistant Page ID

Where can I find this on FactSet?

15308

FactSet Insert menu > Event Calendar (@EC)
support@factset.com
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Viewing the People Reports
Use the People Snapshot report to research information about officers and directors affiliated with public companies, private companies, and private equity firms. In addition to
information such as employment history and compensation, you can access relationships (both corporate and non-corporate) and filings. This version of the People report requires
FactSet 2011.5 or higher.
Click the Lookup button to find
an individual, or start typing a
name to view a list of matching
people. Type-ahead searching
allows you to search on a
person’s title and company
name (e.g., CFO and Microsoft)
and familiar short names (e.g.,
Bill vs. William).

Click the Quick Links icons to
launch the Relationships and
Connections reports, which
provide additional relationship
details and allow you to plot
paths between people and
firms.

Click the Download icon to
download individual sections of
the report to Microsoft Excel.

Click links within the report to
launch additional information.
Clicking a firm name link in
the Board History section
launches the Company
Snapshot report for the
selected firm.

Scroll down the report to view
compensation and options
history, insider transactions,
and more (depending on your
FactSet subscription).

Click a filing link to launch the
associated document in an
HTML Viewer.

Online Assistant Page ID

Where can I find this on FactSet?

13501

FactSet Insert menu > People > Snapshot (@PPL)
support@factset.com
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Monitoring Portfolios in Real Time
Use the Portfolio View display to monitor your portfolio holdings in real time, displaying data such as price, percent change, and intraday contribution on an absolute and/or relative
basis. You can also view dynamically changing charts for your portfolio and/or benchmark at the security or group level. To learn more about tracking your real-time portfolio performance,
launch the eLearning demo on Online Assistant page 15879.
Click the Lookup button to select
Right-click and select "Chart
a portfolio and/or benchmark.
Options" to select what charts
You can also enter a benchmark
to display. You can display up
identifier directly into the Portfolio
to six charts, choosing from
and Benchmark boxes.
the following chart types:
Portfolio Performance, Groups,
Right-click in the chart and select
Constituents, Heatmap, and
"# of Display Bars" to change the
Intraday History.
number of bars shown in the chart.
Right-click in the chart and select
"Data Item" to change the metric
being charted.

Right-click in a Groups or Heatmap
chart and select "Groupings" to
change the grouping classification.

Double-click on a column
heading to sort by that column.

Double-click a bar to go down a
level of grouping. When you get
to the constituent level, doubleclicking will open the News display.
To go back up a level, double-click
anywhere else on the chart.

Click on the News Count to
see a breakdown of the news
by source.
Right-click and select "Options"
to group your portfolio.

Right-click and select "Options" to
customize your columns using data
from your FactSet subscription or
your proprietary data.

Right-click on a column and
select "Group Statistics" or "Total
Row" to calculate statistics at the
group and portfolio levels.

Online Assistant Page ID

Where can I find this on FactSet?

15879

FactSet Insert menu > Portfolio > Portfolio View (@PV)
support@factset.com
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Viewing the Attribution Report in Portfolio Analysis
Portfolio Analysis reports deliver insight into the factors that make up your portfolio and illustrate how your investment decisions affect performance. The Attribution report provides indepth analysis of your portfolio’s return relative to your target benchmark. For a guided tour covering the basics of Portfolio Analysis, launch the eLearning series on Online Assistant
page 13409.
Click the Options button to access all of your report specifications
in one centralized location (e.g., portfolio/benchmark, report
dates, groupings, exclusions). For more information on the
Options dialog box, see Online Assistant page 8835.

Click the Lookup button to
specify your portfolio and
benchmark.
Click the Actions button and
select the "Enable Real Time"
option to view streaming
prices, weights, contribution,
and attribution effects.

Click the Trade Simulation button to
simulate trades in order to determine
the impact your trades may have on
your portfolio’s performance and
composition. For more information
on simulating trades, see Online
Assistant page 12800.

Click the quick links to edit
specific report settings (e.g.,
report dates, economic sector,
and currency).

Right-click on a column or row to
access additional report options.
Select the "Column Help" option
to see a textual definition and
calculation for the column. Select
the "Audit Group Value" option to
view the values behind a security- or
group-level calculation.

Use the Attribution report to
analyze the effects of portfolio
management decisions
including allocation, security
selection, and interaction.

Subscribe to Notify’s "Portfolio
Analytics" category to stay
informed on the latest updates
to Portfolio Analysis.

View the portion of portfolio
excess return attributable to taking
different group bets than the
benchmark with allocation effect.

Use Conditional Formatting to customize a column
based on its relation to a static value or other
columns. For more information about conditional
formatting, see Online Assistant page 16859.

Online Assistant Page ID

Where can I find this on FactSet?

13632

FactSet Insert menu > Portfolio > Portfolio Analysis > Attribution report (@PA)
support@factset.com
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Charting in Portfolio Analysis
Portfolio Analysis lets you chart portfolio and benchmark values to give you a graphical snapshot of performance. Portfolio Analysis offers several predefined charts, but also lets you
manipulate charts to meet your needs. For a guided tour covering the basics of creating charts in Portfolio Analysis, launch the eLearning series on Online Assistant page 16098.
Click the Create Charts button
to view one of the default charts
available or create a new chart.

To print or preview a chart, click
the Chart Options button.
To dynamically adjust chart
data, click the Chart Options
button and select the
"Interactive Mode" option.

To edit a chart element, rightclick the element (e.g., series,
legend) and then select from
the available customization
options.
Click the Chart Layout button to
specify how you want to view charts
(e.g., report and chart side-by-side or
more than one chart at a time).

Subscribe to Notify’s "Portfolio Analytics"
category to stay informed on the latest
updates to Portfolio Analysis.
Online Assistant Page ID

Where can I find this on FactSet?

15478

FactSet Insert menu > Portfolio > Portfolio Analysis (@PA)
support@factset.com
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Using Portfolio Dashboard
Use Portfolio Dashboard to monitor many portfolios at once in a single report. You can view bottom-up performance and predictive, factor-based risk along with top-down, returns-based
performance. To perform deeper analysis on a specific portfolio, you can easily jump to Portfolio Analysis or SPAR (Style, Performance, and Risk). For a guided tour covering the basics of
Portfolio Dashboard, launch the eLearning series on Online Assistant page 16255.
Click the Alerts button to create
alerts and stay up-to-date on portfolio
values’ movements.

Click the Settings button to access
report customization options,
such as specifying your universe,
adding predefined columns, and
creating custom columns. For more
information on the Settings button,
see Online Assistant page 14183.

Click the Add button to add accounts
and holdings-based or returns-based
portfolios to your report.

Double-click any value to launch the corresponding
report in Portfolio Analysis or SPAR.

Subscribe to Notify’s "Portfolio
Analytics" category to stay
informed on the latest updates
to Portfolio Dashboard.

For example, double-clicking the Absolute Total Return
column for the U.S. Mid Cap Growth portfolio takes you
to the Contribution report in Portfolio Analysis. Here you
can see how the total return value 4.57 was calculated.

Online Assistant Page ID

Where can I find this on FactSet?

14181

FactSet Insert menu > Portfolio > Portfolio Dashboard (@PD)
support@factset.com
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Analyzing a Portfolio’s Style, Performance, and Risk
SPAR (Style, Performance, and Risk) lets you analyze your portfolio’s performance against equity and fixed income benchmarks. Dynamically create presentations of your portfolio’s style,
performance, risk, and peer group analysis, which you can easily download to Microsoft PowerPoint. For a guided tour of SPAR, launch the eLearning series on Online Assistant page 16210.
Analyze any portfolio or
combination of portfolios
against a specified
benchmark.

Create custom universes and
screen for funds in Fund Screening.
To jump to Fund Screening from
SPAR, click the Actions button and
select "Launch Fund Screening."
See Online Assistant page 13945 for
more information.

Use the FactSet default
presentation, or customize
your own presentation
by clicking the Manage and
Add New Slide buttons.

Right-click on a chart or report to
set report options such as date
range, colors, chart type, and more.

Set options specific to
your charts and reports,
including dates, statistics,
style sets, and universes.

To add a new chart or report to a
slide within your presentation, drag
and drop charts or reports into the
viewing area. If you do not see the
chart/report selection pane, click on
the arrows in the upper-right corner
to expand the pane.

Insert any combination of
charts and reports into a
slide.

Subscribe to Notify’s "SPAR"
category to stay informed on the
latest updates to SPAR.
Online Assistant Page ID

Where can I find this on FactSet?

12876

FactSet Insert menu > Portfolio > SPAR (@SPR)
support@factset.com
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Managing Databases Using Quick Portfolio
Use Quick Portfolio to view, edit, and quickly upload your proprietary data to an OFDB database. Once you’ve uploaded your data, you can use it in custom reports, Data Downloading,
Screening, Portfolio Analysis, and other FactSet components. For a guided tour covering how to create portfolios and identifier lists in Quick Portfolio, launch the eLearning series on Online
Assistant page 14904.

Click the "Modify Settings" link to
specify index and sorting options.

Click the New File button to create a
new database.

Index options let you modify
characteristics, such as index
methodology and weighting scheme
for custom indices, which can be
used in other applications. See
Online Assistant page 13980 for more
information.

Click the Save button to save the
database.

Enter identifiers in the Enter Symbols
text box to create a ticker list. To
enter multiple identifiers, enter a
space between each identifier.

Click the Clear Data button to
clear all the identifiers and data in
the view. The headings for defined
fields will remain. To delete only a
security and its corresponding data,
select the identifier (or multiple
identifiers) and then click the
Remove button.

Copy proprietary data from Microsoft
Excel into Quick Portfolio. Press
CTRL+C to copy the data from Excel
and CTRL+V to paste the data in
Quick Portfolio.

Click the "Add Field" option to
define a new field. You can select a
predefined field or create a custom
one.

Select a holdings date for your
data. Select the "None" option for
non-time series databases. If you’re
uploading a Date field, the "From
DATE Field" option will be selected
as the holdings date.

Online Assistant Page ID

Where can I find this on FactSet?

13976

FactSet Insert menu > Utilities > Quick Portfolio (@QP)
support@factset.com
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Using Portfolio Utilities
After uploading your proprietary data to FactSet, add the file to Portfolios List Manager in order to analyze the portfolio, custom composite, or benchmark in applications such as Portfolio
Analysis and SPAR. Use Portfolios List Manager along with other Portfolio Utilities to manage composite assets, asset types, parsers, and reconciliation reports.

Select some of the additional components featured in Portfolio Utilities:

++Composite Asset Builder - To construct a composite asset portfolio by using an identifier as
a weighted basket of securities. See Online Assistant page 12556 for more information.

++Asset Type Mappings - To map your portfolio assets to asset types available in FactSet (e.g.,
futures, options). See Online Assistant page 14078 for more information.

++Parser Log Viewer - To monitor your portfolio’s holdings and/or returns upload process in
FactSet. See Online Assistant page 11533 for more information.

++Portfolio Reconciliation Utility - To view production reports or set up alerts on potential
problems with data you upload. See Online Assistant page 14868 for more information.

Select the type of portfolios you want to view
(e.g., holdings, returns) from the By Type dropdown menu.
Use Portfolios List Manager to manage portfolios
and accounts. See Online Assistant page 16457
for more information.

Subscribe to Notify’s "Portfolio
Utilities" category to stay informed on
the latest updates to Portfolio Utilities.

Right-click on any row to
access portfolio options.

Online Assistant Page ID

Where can I find this on FactSet?

12519

FactSet Insert menu > Portfolio > Utilities > Portfolio List Manager (@PVR)
support@factset.com
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Charting Economic Series
Use Economic Analysis’s charting and report-writing options to analyze markets. Create charts or reports for any combination of economic and corporate fundamental time series. View
important economic events and related details within minutes of their release. For a guided tour on charting economic series, launch the eLearning series on Online Assistant page 13704.
Change the chart’s time
period by selecting a period
from the Start Date dropdown menu, or by clicking
the Options button and
choosing the Period tab.

Click the Report button to view the
chart’s corresponding report.

Click the Filters button or right-click
on a column header to narrow your
search results based on country,
database, frequency, or data source.

Highlight recession periods
to add additional meaning to
your data.

Select a series by category
using Series Lookup.
Limit your searches by
category.

Right-click a column in the
Preview pane to apply series
math and transformations.
Subscribe to Notify’s "Market Analytics"
category to stay informed on the latest
updates to Economic Analysis Charting.
Online Assistant Page ID

Where can I find this on FactSet?

13155

FactSet Insert menu > Charting > Economic Analysis Charting (@EAC)
support@factset.com
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Viewing Economic Reports
Launch Economic Reports to view reports that list important economic indicators for more than 60 countries. These reports let you view dozens of relevant economic indicators with a
single mouse click. For a guided tour of Economic Analysis applications, featuring Economic Reports, launch the eLearning demo on Online Assistant page 13536.

Click the source link to change
your database order.

Click the Lookup button to browse
for an economic series or you can
type a series into the Identifier box.

Change the report history or
generate a chart by clicking the
Calendar and Chart buttons.

Select a different frequency
from the drop-down menu.
Economic Reports can also feature
Transformation and Seasonal
Adjustment options.

Select a row and click the Info
button in the report toolbar to
access more information about
the indicator.

View descriptive information on
a series, including frequency,
history, and the data’s source.
Subscribe to Notify’s "Market Analytics"
category to stay informed on the latest
updates to Economic reports.
Online Assistant Page ID

Where can I find this on FactSet?

15195

FactSet Insert menu > Markets > Economic Reports (@ER)
support@factset.com
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Viewing a Country Synopsis
Country Synopsis reports deliver a detailed view of the country in question, and link to other reports, such as benchmark reports, economic detailed reports, and estimate reports for
commodities. Access Country Synopsis reports directly, or through Company reports and Portfolio Analysis.
Click the Tools button to access
printing and downloading
options.

Hover over the credit rating to
see a 10-year history.

Click a link in the Economic
Summary section to view a
report on that particular series.

Grab a component title to dragand-drop it around the report
and arrange each to best fit
your analysis.

Click an index name to launch
a Constituents or Benchmark
report.

Click a link to open an
adjustable 52-week graph of
the selected line item.

Online Assistant Page ID

Where can I find this on FactSet?

15382

FactSet Insert menu > Markets > Country Synopsis
support@factset.com
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Viewing Index Data
The Markets and Quotes/Prices categories allow you to view real-time data for major indices, create constituent-level reports, and country and industry breakdowns for a variety of
benchmark families. In addition to the reports shown here, you can also access the Earnings Scorecard (@ESC), Matrix (@IMX), and Performance & Valuation (@P&V) reports. To learn
more about using different components in the Markets tab, launch the eLearning demo on Online Assistant page 15890.

View real-time data for major global
indices in Market Watch (@MW or
FactSet Insert menu > Quotes/Prices).

Right-click on any index to access
FactSet’s performance, estimate,
growth, and valuation data in the Full
Quote display.

Select from Close and Time Series
reports in the Index Breakdown
(@XB), then customize the currency,
return type, report date, and more.

With the Constituents report (@CON),
you can view constituent-level data
for a broad array of index families and
groupings.
Instantly send equity or fixed income
indices to the Equity Screening or
Debt Screening applications for
further analysis.

Subscribe to Notify’s "Market Analytics" and
"Real-Time Data and Displays" categories to
stay informed on the latest product updates.

Use expand/collapse functionality
for your different grouping levels.

Add or remove data columns from
your report and change your options.
Online Assistant Page ID

Where can I find this on FactSet?

15890

FactSet Insert menu > Markets or Quotes/Prices
support@factset.com

Double-click on an index to display
its key statistics and constituents.
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Using Equity Screening
Equity Screening allows you to test and confirm investment strategies across all databases simultaneously. You can screen on your own investable universe or on tens of thousands of
securities worldwide. FactSet offers a vast library of predefined items, plus you can also develop your own proprietary screening criteria using any data available. For a guided tour of
Universal Screening, launch the eLearning series on Online Assistant page 16208.
Click the Equity, Debt,
Holder, or Fund buttons to
change your report type in
Universal Screening.

Click the Screen Dashboard button to access
sample screens that serve as building blocks
when creating your own custom screens.

Select the Format dropdown menu to apply
groupings, sort by security
and groupings, apply multifactor ranking, and more.

Click the Open button to access
your saved reports.

Use "type-ahead" functionality
in the Universe Limitation
field or click the Limit button
to construct a universe of
securities defined by one or
more limitations. You can limit
your screen based on a number
of factors, both qualitative and
quantitative.

Click the Report button to
display the securities that
meet your criteria.
Add comments to any
parameter by going to the
Column Format or Column
Settings dialogs.

Tip: To save the list of securities that pass
your screen to an OFDB file, PRT file, or
online spreadsheet report, click the Output
Options button
and select "Archive
Screen Results." See Online Assistant page
286 for more details on archiving data.

Create composite charts
on-the-fly by pressing CTRL
and selecting the identifiers
in the Report view. Rightclick and select "Chart as
Composite," then select
the chart type. See Online
Assistant page 16230 for
more details on charting
composites.

Subscribe to Notify’s "FactSet Screening" category to stay
informed on the latest updates to Universal Screening.

Online Assistant Page ID

Where can I find this on FactSet?

249

FactSet Insert menu > Screening/Report Writing > Universal Screening > Equity Screening (@US)
support@factset.com
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Limiting the Universe
Use Universe Builder to construct a "universe" of securities defined by one or more limitations. Limitations are grouped by category and you can save your universe as a profile or
portfolio to use throughout FactSet applications, including Universal Screening, Interactive Charting, and Identifier Lookup. Click the Limit button in Universal Screening to launch
Universe Builder. For a guided tour of Universe Builder, launch the eLearning demo on Online Assistant page 16208.
Go to the Actions drop-down
menu to select options like
including all dually-listed U.S./
Canadian securities and all
Cash identifiers, or excluding
inactive securities, secondary
listings, and non-equity
securities from your universe.

Define your universe by selecting
universe limitations from the
category tabs. See Online
Assistant page 12888 for more
information on each category.

Choose Limit Wizard to create
formula limits based on Price,
Performance, and Financial data
items in your Equity Screening
report.

To include a limit, double-click
the item or select the item and
click the Include button. To
exclude a limit, double-click the
item twice or select the item
and click the Exclude button.

Choose Favorite to select
frequently used limits that are
bookmarked. You can bookmark a
limit as a Personal favorite, Client
favorite, or both, by clicking the
Star icon
to the right of the
limit in Universe Builder.

Click the Constituents button
to preview the list of securities
that pass your limitations. You
can download the identifiers and
security names to a spreadsheet
or text file, or create a Quick
Portfolio with the list of identifiers.

Tip: You can also use "type-ahead" searching to quickly find limits for your
Universal Screening report. Results for your keyword search will be returned
by industry, index, geographic location, exchange, etc. Type-ahead searching
is available in Universal Screening and most tabs in Universal Builder. For
more information about this functionality, see Online Assistant page 250.
Online Assistant Page ID

Where can I find this on FactSet?

333

FactSet Insert menu > Screening / Report Writing > Universal Screening > Limit button
support@factset.com
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Creating and Editing Parameters
Click the Formula Lookup button
to create parameters in your screening report. Formula Lookup is a utility that helps you find formulas in order to incorporate FactSet data into
your screens and reports. To learn more about how to use Formula Lookup, launch the eLearning demo on Online Assistant page 14930.

1. Click the Formula Lookup
button to search for a formula. You
can also edit, delete, move, and
change parameter settings in the
Parameters section.
2. Click the Sources button to
choose a specific data source. In this
example, the FactSet Fundamentals
formula library is selected.

3. Click the Information button to
view a detailed description of the
selected data source.
You can edit your parameters
to add relational operators and
compare one formula to another.
To edit formulas, click on the
formula in the Workspace, then
make your changes.

4. After you select a formula, specify
your formula arguments.
5. Click the Add Selected button
to include the formula in your
Workspace or double-click the
highlighted formula.

In this example, the parameter will
return all securities whose annual
total debt is less than 95% of the
previous year’s annual total debt.

6. Click the OK button to add the new
parameter to your report.
Online Assistant Page ID

Where can I find this on FactSet?
FactSet Insert menu > Screening/Report Writing > Universal Screening > Equity Screening > Formula Lookup button
support@factset.com
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Screening for Ideas
Idea Screening 2.0 provides a workflow-driven, customizable application that allows you to screen for potential investment opportunities, find potential buyers, track trends, and identify
precedent transactions. You can choose to view FactSet’s customizable predefined screens or create your own screens based on criteria you specify. To learn more about Idea Screening,
launch the eLearning demo on Online Assistant page 16590.
Choose the Home tab to create
new screens and launch existing
screens from your Screen
Library.

Click the Adjust Logic button to change the
screening logic for your included parameters.

Enter a keyword to search
for specific items. You can
also filter results based on
FactSet Recommended items or
Personal/Client favorites.

To view detailed information on an
entity within your report results,
right-click and select "Launch
Report." You can also select
"Broadcast" to send the identifier to
the master identifier box, allowing
you to easily analyze the entity in
other FactSet reports.

To add a new parameter to
your screen, drag the desired
parameter from the Search
Items tab into the report.
To view the item definition,
hover your mouse over the
parameter’s Information icon.
For more information on working
with your screen parameters,
see Online Assistant page 16697.

Subscribe to Notify’s "FactSet Screening"
category to stay informed on the latest
updates to Idea Screening.

You can sort your report, move and
delete columns, download results,
and more in the Results view.
Online Assistant Page ID

Where can I find this on FactSet?

16590

FactSet Insert menu > Screening/Report Writing > Idea Screening 2.0 (@ISC2)
support@factset.com

Click the View Results button to
analyze your results based on the
criteria you’ve selected.
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Charting Market Data
Use the Chart display to chart company-specific market data over different frequencies. You can also create indexed and relative price charts to perform company versus benchmark
comparisons.
Toggle between indexed or
Click the Profile button
Click the Upper or Lower
relative charts by clicking the
to access default FactSet
buttons to add technical
Index and Relative buttons.
charts or your custom
indicators.
chart
profiles.
Use the Drawing toolbar
Click the Chart Options button and choose a
to select from a number of
chart modes and drawing.

tab to customize the chart:
++Dates - To change the period, interval, and
calendar
++Options - To change formatting such as
chart type and scaling
++Upper Indicators - To add upper indicators
such as moving averages and annotations
++Lower Indicators - To add lower indicators
such as MACD and momentum
++Multiple Identifiers - To create an indexed
or relative chart
++Lines and Highlights - To add relevant
fundamental items or proprietary data

Multiple Identifers
Crosshairs
Zoom
Price Change Monitor
Peer Mode
Horizontal Lines
Trendlines
Fibonacci Retracements

Click on an annotation to view the historical/
detailed report or corresponding news
document.
Double-click on the chart to launch a
Company News display with stories from the
corresponding date.
View the price change between
two dates using the Price Change
Monitor. For more information
on the options available, see
Online Assistant page 16828.

Online Assistant Page ID

Where can I find this on FactSet?

15931

FactSet Insert menu > Charting > Chart (@C)
support@factset.com

To change a chart’s date range, click the
appropriate time period. To select a custom
date range, click the Calendar button.
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Charting Interactively
Use Interactive Charting to create flexible charts depicting company and non-company data. Predefined series include pricing, financial, estimate, and valuation data. For a guided tour
covering the basics of Interactive Charting, launch the eLearning series on Online Assistant page 16214.
Toggle between indexed or
relative charts by clicking
the Index and Relative
buttons.

Click the Drawing Tools
to view the Drawing
button
toolbar in the left pane (as
shown). You can then select
from a number of drawing
tools, including crosshairs
and trendlines. For more
information on drawing tools,
see Online Assistant page 15282.

To view the underlying data
behind a chart, click the
Show Report View button.
Add additional identifiers in
the Compare To dialog box.
To select dynamic default
benchmarks, click the
Lookup button and select
from the available index
families.

To modify the up/down color
scheme, crosshair cursor type,
and other settings, such as
calendar and currency, select
the "Application Settings" option
from the Quick Actions dropdown menu.

To change a chart’s date
range, click the appropriate
button in the lower right
corner. To select a custom
date range, click the
Calendar button.

Click the Add Plot button to add
additional plots to your chart.
To remove plots, right-click on
the plot area and select Plot
Options > Delete Plot or press
the DELETE key.
To add dynamic annotations, such as
corporate actions, insider trading, and M&A
activity to your chart, right-click on the
series and select the "Annotations" option.

Subscribe to Notify’s "Charting on
FactSet" category to stay informed on the
latest updates to Interactive Charting.

Online Assistant Page ID

Where can I find this on FactSet?

16021

FactSet Insert menu > Charting > Interactive Charting (@IC)
support@factset.com

Tip: Right-click on the date
section to add or remove
the date buttons displayed
by default.
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Using the Web Browser
The Web Browser display allows you to integrate your browser into FactSet. You can view company homepages and public websites. You can also customize the available website links to
meet your needs. For example, you can configure the Web Browser to automatically enter a company identifier in your favorite internal or external research sites.
Click the Back and Forward buttons to
navigate back to the previous page or
forward to the next page in the history.

Create a custom tab that
includes all of the websites
that you frequently visit.

You can also save a list of your favorite websites in the drop-down
menu for easy, one-click access. For more information on saving
frequently-used web addresses, see Online Assistant page 15913.

To find a security
identifier, click the
Lookup button.

Select "Web Address"
from the drop-down
menu and enter the
URL of a website you
wish to view.

Select "Company Homepage" from the
drop-down menu and enter an identifier.
By default, when you enter an identifier,
the company’s homepage will display.

Tip: Subscribe to a website’s RSS feed by right-clicking on the link
for the RSS feed and selecting "Subscribe to RSS Feed." The Add
Feed dialog box in RSS Reader will open with the URL for the RSS
feed. Click the Add button to complete the subscription process.
Online Assistant Page ID

Where can I find this on FactSet?

15912

FactSet Insert menu > Web Browser (@WEB)
support@factset.com
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Using FactSet’s Mobile Solutions
Use FactSet’s mobile solutions to access the same global market information and company intelligence that you receive on your desktop on your mobile device.
You can do the following using FactSet’s mobile solutions:
++Quickly switch between summary and detailed views of portfolios and watch lists stored in FactSet
++Access Top News summaries from Dow Jones and news for an individual company
++Monitor global market data for major world indices, commodities, and FX Rates
++Examine deep company data including estimates, event details, M&A activity, ownership
information, and debt
++Chart prices for an individual security or compare the performance of multiple securities
For help using FactSet for the iPad,
see Online Assistant page 16634.

For help using
FactSet Wireless
Plus for the
BlackBerry, see
Online Assistant
page 15719.

For help using FactSet for
the iPhone, see Online
Assistant page 16435.

Subscribe to Notify’s "FactSet
Platform" category to stay
informed on the latest
updates for mobile solutions.
Online Assistant Page ID

Where can I find this on FactSet?

15637

FactSet Mobile Solutions
support@factset.com
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Configuring and Installing FactSet’s Mobile Solutions
Prior to using FactSet’s mobile solutions, you must configure your mobile login settings in FactSet. To learn more about configuring wireless, launch the eLearning demo on Online
Assistant page 14889.

Configuring Mobile Access
1. Go to FactSet Insert menu > Utilities
> Wireless Configuration to enable
wireless. (Or right-click in a Portfolio
View or Market Watch display and go
to Wireless > Configure Wireless.)

Installing FactSet on Your Mobile Device
2. Click the "Set Now" hyperlink to set your
password.

On your iPhone:
1. Go to the App Store on your iPhone and choose the Search tab.
2. Search for "FactSet" and select it from the results.
3. Tap "Free" > "Install".
For help using FactSet for the iPhone, see Online Assistant page 16435.

3. Create a password that contains a capital
letter, a number, and is eight or more
characters total.

The indicator will turn green once you have
enabled wireless access.

Tip: To make a new portfolio or watch list
available on your mobile device, click the
"+ Enable New File" hyperlink. For more
information about adding portfolios and watch
lists, see Online Assistant page 14889.

On your BlackBerry:
1. From the browser on your mobile device, go to: http://www.factset.
com/wireless/wp.html
2. When prompted, click Download.
3. Once the installation is complete, click Run to start the application, or
OK to return to the home screen.
4. To launch Wireless from the home screen, locate and select the blue
icon . (Depending on your mobile device and IT policy, the icon may
be on the home screen, or in a "Downloads" or "Applications" folder.)
For additional installation options and help using FactSet Wireless Plus on
your BlackBerry, start from Online Assistant page 15641.
Once you launch FactSet on your mobile device, enter your username, serial
number, and the wireless password set during the configuration process.

Subscribe to Notify’s "FactSet Platform"
category to stay informed on the latest
updates for mobile solutions.

Online Assistant Page ID

Where can I find this on FactSet?

15637

FactSet Insert menu > Utilities > Wireless Configuration
support@factset.com

On your iPad:
1. Launch iTunes.
2. Choose the iTunes Store category from the left pane.
3. Search by keyword "factset".
4. Click the Install button in the iPad Apps section.
5. Click the Install button again to confirm the download.
For help using FactSet for the iPad, see Online Assistant page 16634.
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Understanding =FDS Codes
=FDS is a Microsoft Excel function that dynamically pulls data stored on FactSet servers, allowing you to automatically update your spreadsheet data. For a guided tour about building
=FDS codes, launch the eLearning series on Online Assistant page 16644.
The following are benefits to building models with =FDS codes:
++Allows FactSet data to be dynamically incorporated into an Excel model
++Uses Excel functionality, such as cell referencing
++Allows you to combine FactSet formulas with other Excel functions (e.g., an =FDS code can be divided by or added to another cell)

Basic Syntax
=FDS("IDENTIFIER","FORMULA(START_DATE,END_DATE,FREQUENCY)")
++Each code has two distinct parts: the identifier of the security or index of interest and the formula of the item being retrieved. Both of these items are enclosed
in quotation marks.

++You can write the identifier as an Exchange Ticker, such as XOM for Exxon Mobile Corporation, or a SEDOL, such as 0798059 for BP PLC.
Note: SEDOL stands for Stock Exchange Daily Official List.

++This syntax is the basic syntax for creating an =FDS code, but the arguments will vary based on the formula you select. For example, not all formulas include
a start date, end date, and frequency.

Examples
To retrieve the latest closing price for Exxon Mobile Corporation, the =FDS code is:

=FDS("XOM","P_PRICE(0D)")

To retrieve the latest annual sales value for BP PLC using the FactSet Global library, the =FDS code is:

=FDS("0798059","FG_SALES(0)")
Subscribe to Notify’s "FactSet Office
Integration" category to stay informed on the
latest updates to data retrieval on FactSet.
support@factset.com
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Building =FDS Codes
Dates
=FDS codes accept both relative and absolute dates as formula arguments. An absolute date is a specific point in time, while a relative date represents a date relative to the most
recently updated period.
Examples of Absolute Dates

Examples of Relative Dates

Day (MM/DD/YYYY): 7/11/1997, 1/1/2003, 3/6/2008

Most recent trading day: 0D

Month-end: 6/1998, 4/2003, 11/2006, 5/2008

One trading day prior to the most recent trading day: -1D

Fiscal quarter-end: 99/1F, 2005/3F, 2008/2F

Seven days prior to the most recent trading day: -1AW

Calendar quarter-end: 1999/1C, 2005/3C, 08/2C

Last trading day of the most recent week: 0W

Semi-annual period-end: 2002/1S, 2002/2S, 2003/1S

Last trading day three weeks ago: -2W

Fiscal year-end: 1999, 2005, 07

One month ago from the most recent trading day: -1AM
Last trading day twelve months ago: -11M
Last trading day of the most recent fiscal year: 0Y

Frequency Options
D
W
AW
M

Daily
Weekly
Actual Weekly
Monthly

AM
Q
CQ
AQ

Actual Monthly
Fiscal Quarterly
Calendar Quarterly
Actual Quarterly

Y
CY
AY
RANGE

Fiscal Yearly
Calendar Yearly
Actual Yearly
Range between two dates

Tip: You can also mix absolute and relative dates using FactSet formulas. For example, entering 12/31/2010-2AW returns data as of two actual weeks (14 days) before the end of 2010.
Subscribe to Notify’s "FactSet Office
Integration" category to stay informed on the
latest updates to data retrieval on FactSet.
support@factset.com
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Building =FDS Codes with Formula Lookup
Formula Lookup 2.0 makes it easy to incorporate FactSet data into your models and reports by helping you find formulas and build =FDS codes. For a guided tour on how to use Formula
Lookup, launch the eLearning series on Online Assistant page 16334.

Navigating New Formula Lookup
To add formulas using the new version of Formula Lookup:
1. In Microsoft Excel 2010, go to FactSet > Insert Formula > Formula Lookup to launch Formula Lookup.
2. Search for the formula and specify the formula arguments, such as dates and currency.
3. Click the Add Selected button to preview the data that you’ve selected.
4. Click the OK button to add the formula to your spreadsheet.
To find a formula, type a
keyword into the Search box
and click the Search button or
press ENTER.

To narrow your search, select a
database from the Sources dropdown menu. Select the FactSet
Recommended library to access
the most commonly-requested
and frequently-used formulas
across all data sources.

Click the Information button to
see additional details about the
database source, such as the
type of data available.

View the most commonly
requested formulas throughout
Formula Lookup, denoted by
the
icon.

Click the Cell Picker button
to cell reference the identifier
and/or formula arguments, such
as start date. You can also type
the cell reference directly in the
argument box using the format,
=cell_address (e.g., =A1).

Click the Star icon to bookmark
a formula as a “favorite.” To
search for formulas that have
been marked as favorites,
select “Favorites” from the
Sources drop-down menu.

Online Assistant Page ID
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Inserting Formulas with FactSet Sidebar
FactSet Sidebar is a one stop-shop for the most common tasks in Microsoft Excel. This tipsheet highlights Sidebar’s Insert tab, which streamlines the process of creating FactSet formulas
in Excel. The tab features more targeted search results, type-ahead search functionality for identifiers, the ability to cell reference across Excel workbooks and worksheets, a real-time
preview, function-building capabilities, and more. To insert a FactSet formula, choose the Insert tab in Sidebar or select "Insert Formula" from the Insert Formula drop-down menu within
the FactSet ribbon in Excel. For a guided tour of FactSet Sidebar, launch the eLearning series on Online Assistant page 16786.
If you’ve selected the =FDS Mode in the Settings button of
Sidebar, the Identifier section is displayed. Enter a company’s
identifier and press ENTER or search for an identifier using
type-ahead functionality. You can also click the Lookup button
to search for an identifier. The Identifier section allows you to
enter multiple companies at once.

Search for a formula by typing a keyword or phrase into the
Enter Keyword box and pressing ENTER. By default, you’ll
see a list of formula matches from all of the databases you
subscribe to. To organize your search results, go to the List
drop-down menu.

To limit your search results to FactSet Recommended formulas
only, click the FactSet Recommended button
. To control
the formula libraries you are searching through, click the Filter
button
. In this example, a keyword search for Sales
returns all Sales formulas from the FactSet Fundamentals
Consolidated formula library.

You can specify the report basis, date, frequency, currency,
and other formula arguments that are specific to the data item
you’ve selected using the drop-down menus or cell references.

To cell reference an identifier or formula argument across Excel
workbooks and worksheets, click the Select a Cell Reference
button
.

Once you’ve selected a data item, expand the Definition
section to view the formula name, data source, and
description.

You can apply a function to your data item within the Formula
Workspace section by clicking the Function button
. A
list of functions that correspond to the data item will appear.
To learn more about applying functions in Sidebar, see Online
Assistant page 16779.

Once you’ve specified an identifier and selected a data item,
you can expand the Formula Workspace section to add a
function. The real-time preview in Excel allows you to view
where the data will be placed in your spreadsheet, along with
the data that will be outputted once you click the
Insert button.

Click the Insert button to output data to your Excel
spreadsheet.
Online Assistant Page ID

Where can I find this on FactSet?

16772

Microsoft Excel 2007/2010 > FactSet ribbon > Show or Hide button > Sidebar
support@factset.com
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Using Filings Wizard
Filings Wizard lets you quickly insert EDGAR 10K and 10Q tables into Microsoft Excel and reference those tables in the EDGAR filing. To access the Filings Wizard utility in Microsoft Excel
2010, go to the FactSet tab, and select "Filings Wizard" from the Filings drop-down menu.
Enter a company’s identifier
or click the Lookup button to
search for an identifier.

To view the complete filing, click a
linked report in the spreadsheet.

Select multiple identifiers by
referencing your identifier list from a
Microsoft Excel report.
Select the check boxes to indicate
which documents you want the search
to return.

Use the Destination drop-down menu
to specify the destination for the tables.
Select the “Separate sheets in New
Workbook” option to download each
document table to a separate sheet in
the Excel workbook.
Click the OK button to
download the tables
into Microsoft Excel.

Subscribe to Notify’s "Company
Analytics" category to stay informed on
the latest updates to Fillings Wizard.
support@factset.com

Online Assistant Page ID
14237
(54)

Copyright © 2012 FactSet Research Systems Inc. All rights reserved.

Formatting with Spreadsheet Tools
FactSet’s Spreadsheet Tools significantly reduce the time required to create, format, and audit Microsoft Excel spreadsheets by providing over 130 customizable tools. Open the
Examples Workbook to practice using all the spreadsheet tools by choosing the FactSet tab > Help > Spreadsheet Tools Examples Workbook. For a guided tour on formatting your
spreadsheets using Spreadsheet Tools, launch the eLearning series on Online Assistant page 16170.
Use custom SmartCycles to format
all elements of a table (press
CTRL+ALT+1, CTRL+ALT+2, etc.), from
font weight and color, to cell border
and fill, with a single key combination.
Each key combination can hold up to
five formats.

Automatically color your data based on
input type: formulas, links, or standard
inputs.

Common formatting and utility hot key tools:
CTRL+SHIFT+$
CTRL+SHIFT+@
CTRL+SHIFT+%
CTRL+,/.
CTRL+SHIFT+B
CTRL+SHIFT+C
CTRL+SHIFT+D/R
CTRL+SHIFT+E

++Currency 			
++Date				
++Percent			
++Increase/decrease decimal
++Borders			
++Centering			
++Smart copy down/right		
++Check for errors			

Quickly view a cell’s precedents (press
CTRL+SHIFT+{) or dependents (press
CTRL+SHIFT+}). Audit multiple cells,
even across multiple workbooks.

Subscribe to Notify’s "FactSet Office
Integration" category to stay informed
on the latest updates to Modeling Tools.
support@factset.com
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Using Modeling Tools
Modeling Tools significantly reduces the time it takes to create and audit Microsoft Excel spreadsheets. To practice using all of the tools, choose the FactSet tab > Help > Modeling Tools
Examples Workbook. For a guided tour on using Modeling Tools, launch the eLearning series on Online Assistant pages 16170.
Replicate a range of cells
to a specified number of
spreadsheet tabs. Highlight
the cells, then click Modeling
Tools > Replicate Module.

Add a Growth Driver to forecast
an existing line item based on its
growth projections.

Modeling Tools also offers additional forecast drivers:

Insert a Sum Summary to present a summary of the components
of the total.

++Add Ratio Driver - based on projections of one line
item’s proportion to another

++Add Price * Volume Buildup - based on
projections of the price of one or more goods and
the volume of each good sold
++Add Market Size * Market Share Buildup - based
on projections of market size of an industry or
product line and the market share captured by a
given company or business unit
++Add Other Product Buildup - based on projections
of two other line items that can be multiplied
together to result in the original line item

Other tools let you quickly summarize a sum formula or insert a
CAGR formula to summarize a line item’s trend:
++Insert Contribution Analysis - inserts a contribution analysis
below a line item that is a sum of other line items
++Insert CAGR - inserts a CAGR formula for an existing line item
or series
++Convert CAGR - inserts a formula to convert an existing CAGR
to a new CAGR based on a different time period

Subscribe to Notify’s "FactSet Office
Integration" category to stay informed
on the latest updates to Modeling Tools.
support@factset.com

Online Assistant Page ID
15416
(56)

Copyright © 2012 FactSet Research Systems Inc. All rights reserved.

Using the Source Document Manager
The Source Document Manager is a fully functioning, standalone Internet browser that links data between Microsoft Excel and either PDF or HTML files with click-through back to source
filings. Access Source Document Manager in Microsoft Excel 2010 by choosing the FactSet tab and selecting “Source Document Manager” from the Filings drop-down menu. For a guided
tour on linking items using the Source Document Manager, launch the eLearning demo on Online Assistant pages 16170.

Find standard browser features like tabs
and favorites in the toolbar.
Export individual pieces of data,
paragraphs, or whole tables
(shown) using the sections in
the sidebar.

Click the Open button to open and link to
a local HTML or text file.

Filter your export items by
keyword, table size, number
format, and more.

Quickly navigate through the
document using the Previous
and Next buttons, or use your
keyboard arrows. Then, export
the data to Excel by clicking the
Send to Excel button or pressing
ENTER.

Click the linked value in Sidebar to open
Source Document Manager and return
directly to the original source file.

Quickly link to a different value
by clicking the Edit button.

Subscribe to Notify’s "FactSet Office Integration"
category to stay informed on the latest updates
to Source Document Manager.
support@factset.com

Tip: If a link breaks, the Edit button will be replaced
with a Restore button
for easy link repair.
Online Assistant Page ID
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Charting Data Using ActiveGraph
Use ActiveGraph to create easy-to-update, pitchbook-ready financial graphs using your firm’s corporate colors, fonts, and styles. To launch ActiveGraph in Microsoft Word, PowerPoint,
and Excel, go to FactSet > ActiveGraph > Insert ActiveGraph. You can update the graph at a later date by double-clicking on the graph to activate it, right-clicking, and selecting the
"Refresh ActiveGraph" option. For a guided tour showing you how to use ActiveGraph, launch the eLearning series on Online Assistant page 14796.
Enter an identifier(s) here or click
the Lookup button to search for an
identifier.

Select a graph category and type
(e.g., Price, Valuation, Estimates)
by going to the Charts drop-down
menu.

Click the Data button to modify the
data behind the graph, or to add
your own data to the graph.

Click the Save button to create a
library of custom charts to share
with your colleagues.

A real-time preview of your graph
appears in the top pane. Right-click
and select "Format" to change the
graph’s colors, titles, legend, or axes.

Click the Annotations button to
launch the Annotations view, where
you can add and manage custom
annotations.

Select a time period and frequency
for the graph. (For some graphs,
you may need to specify additional
options.)

To add dynamic annotations, select
a check box for each annotation
type you’d like to display in your
chart.

Click the Add Series button to
quickly add an average or median
line for a series in the chart, or to
add a custom series to the chart.

Click the OK button to insert the
graph into your Word, PowerPoint,
or Excel document.

Click the Help button for
detailed assistance.
Subscribe to Notify’s "FactSet Office
Integration" category to stay informed
on the latest updates to ActiveGraph.
support@factset.com
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Accessing the Report Gallery in Quick Report
Report Gallery within Quick Report offers a number of reports, either based on =FDS templates or other predefined reports. All reports are generated as Microsoft Excel files, which you
can save and update at a later time. You can use these predefined reports as building blocks for creating your own =FDS code reports. The Report Gallery also allows you to store you own
Excel templates for easy access. For a guided tour on how to use Quick Report, launch the eLearning series on Online Assistant page 16441.
Click the New Report button
to create a customized report.
See Online Assistant page
16305 for more details.

Click the My Data button to
create and manage your data:
portfolios, series, or composites.

Click the Properties
button to show the properties
of the equity, index, or
composite selected.

Use the report type-ahead
search box to narrow your
selection. If no report matches
your search criteria, the category
name turns red.

Type the name, abbreviation,
or identifier in the Identifier
box to search and filter your
results.

Flag your favorite reports by
selecting the
icon next to the
report name.

Hover over an equity, index,
or private company to view a
description of the item.

Choose the Personal or Client
tabs to access custom models
you uploaded as favorite reports.

Click a report name to display
a preview. Hover over the
name to see a description of
the report.

Select several reports and
choose how you want to
display each (e.g., in separate
worksheets or workbooks).

Subscribe to Notify’s "FactSet Office Integration" category
to stay informed on the latest updates to Quick Report.
Online Assistant Page ID
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16337

Microsoft Excel 2007/2010 > FactSet ribbon > Quick Report > Report Gallery button
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Using Presentation Linking and Formatting
Presentation Linking and Formatting enables you to send updateable Microsoft Excel-driven tables, text, pictures, and charts to PowerPoint and Word. This page walks you through the
steps necessary to create a presentation, import the data from Excel, update the data, and change source files. For a guided tour on using Presentation Linking and Formatting to create
presentations, launch the eLearning series on Online Assistant page 16170.

PowerPoint 2010 ribbon

Excel 2010 ribbon

Creating a Presentation in PowerPoint

Updating Linked Items

1. Insert a new, custom presentation by clicking the New Presentation button.
2. Click the Insert Slides button, select the slide format you want, and click Insert.
Tip: Import and link standard slide content (e.g., bios, case studies, league
tables) by clicking the Browse button on the Insert Slides dialog box.

If the data in your Excel file changes, you can update your linked items in PowerPoint
and Word by right-clicking them and selecting Refresh Excel Links.
Update multiple items by clicking Manage Links > Manage Excel Links.
Click the Select All button and then Update.

Exporting Excel Data

Switching Source Files Automatically

When exporting data, first select in PowerPoint a location for the exported data
to appear. In Excel, all exporting options appear in the Export Data section of the
FactSet tab, grouped by destination application.
++Table as Picture - Exports data from a group of selected contiguous cells
++Table as Word Table - Exports the selected table as an embedded Word table
++Table as MS Graph Chart (PowerPoint only) - Exports the selected table
as a Microsoft graph
++Chart as Picture - Exports the selected chart
++Cell as Text - Exports data from the selected cell as updatable text

To switch the source to a file with the same name but a different path:
1. In Excel, select Settings > Presentation and Linking.
In the General tab, select all three options in the Link Healing Tools section.
2. Import data from an Excel file.
3. Save the Excel file to preserve the link information, then close it and move it to
another location.
4. Open the file from its new location.
5. Click Refresh > Selected (or All) Excel Links.
6. You will then see a prompt asking if you want to update from the open file that
has the same name, but a different file path.

Switching Source Files
If you link to a file (e.g., Model1.xls) and then save a version of that file with
another name, you can change the linked source to the new file since both files
have the same named ranges.
To switch your source file:
1. Open the new source Excel file.
2. In PowerPoint, click Manage Links > Manage Excel Links.
3. Choose the Filters tab and select the original file from the Source File
drop-down menu.
4. Choose the Source Data tab, click Select All, and then click Edit.
5. In the Source File drop-down, select your new file. Click OK.
support@factset.com
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